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This guide contains information about product settings and service levels.
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Documentation

The documentation set for Deep Discovery Analyzer includes the following:

TABLE 1. Product Documentation

DOCUMENT

DESCRIPTION

Administrator's Guide

PDF documentation provided with the product or
downloadable from the Trend Micro website.

The Administrator's Guide contains detailed instructions on
how to configure and manage Deep Discovery Analyzer, and
explanations on Deep Discovery Analyzer concepts and
features.

Installation and Deployment
Guide

PDF documentation provided with the product or
downloadable from the Trend Micro website.

The Installation and Deployment Guide contains information
about requirements and procedures for planning deployment,
installing Deep Discovery Analyzer, and using the
Preconfiguration Console to set initial configurations and
perform system tasks.

Syslog Content Mapping
Guide

PDF documentation provided with the product or
downloadable from the Trend Micro website.

The Syslog Content Mapping Guide provides information about
log management standards and syntaxes for implementing
syslog events in Deep Discovery Analyzer.

Quick Start Card

The Quick Start Card provides user-friendly instructions on
connecting Deep Discovery Analyzer to your network and on
performing the initial configuration.

Readme

The Readme contains late-breaking product information that is
not found in the online or printed documentation. Topics
include a description of new features, known issues, and
product release history.
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DOCUMENT DESCRIPTION

Online Help Web-based documentation that is accessible from the Deep
Discovery Analyzer management console.

The Online Help contains explanations of Deep Discovery
Analyzer components and features, as well as procedures
needed to configure Deep Discovery Analyzer.

Support Portal The Support Portal is an online database of problem-solving
and troubleshooting information. It provides the latest
information about known product issues. To access the
Support Portal, go to the following website:

http://success.trendmicro.com

View and download product documentation from the Trend Micro Online
Help Center:

http://docs.trendmicro.com/en-us/home.aspx

Audience

The Deep Discovery Analyzer documentation is written for IT administrators
and security analysts. The documentation assumes that the reader has an in-
depth knowledge of networking and information security, including the
following topics:

«  Network topologies
- Database management
+  Antivirus and content security protection

The documentation does not assume the reader has any knowledge of
sandbox environments or threat event correlation.

Document Conventions

The documentation uses the following conventions:



http://success.trendmicro.com
http://docs.trendmicro.com/en-us/home.aspx
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TABLE 2. Document Conventions

CONVENTION DESCRIPTION

UPPER CASE Acronyms, abbreviations, and names of certain commands
and keys on the keyboard

Bold Menus and menu commands, command buttons, tabs, and
options

Italics References to other documents

Monospace Sample command lines, program code, web URLs, file names,

and program output

Navigation > Path The navigation path to reach a particular screen

For example, File > Save means, click File and then click
Save on the interface

Configuration notes

ﬁ’ Note

Q Tip Recommendations or suggestions

. Information regarding required or default configuration
Important . A
settings and product limitations

ﬁ WARNING!

Critical actions and configuration options

Terminology
TERMINOLOGY DESCRIPTION
ActiveUpdate Server Provides updates for product components, including pattern

files. Trend Micro regularly releases component updates
through the Trend Micro ActiveUpdate server.
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TERMINOLOGY

DESCRIPTION

Active primary appliance

Clustered appliance with which all management tasks are
performed. Retains all configuration settings and allocates
submissions to secondary appliances for performance
improvement.

Administrator

The person managing Deep Discovery Analyzer

Clustering

Multiple standalone Deep Discovery Analyzer appliances can
be deployed and configured to form a cluster that provides
fault tolerance, improved performance, or a combination
thereof.

Custom port

A hardware port that connects Deep Discovery Analyzer to an
isolated network dedicated to sandbox analysis

Dashboard

Ul screen on which widgets are displayed

High availability cluster

In a high availability cluster, one appliance acts as the active
primary appliance, and one acts as the passive primary
appliance. The passive primary appliance automatically takes
over as the new active primary appliance if the active primary
appliance encounters an error and is unable to recover.

Load-balancing cluster

In a load-balancing cluster, one appliance acts as the active
primary appliance, and any additional appliances act as
secondary appliances. The secondary appliances process
submissions allocated by the active primary appliance for
performance improvement.

Management console

A web-based user interface for managing a product.

Management port

A hardware port that connects to the management network.

Passive primary appliance

Clustered appliance that is on standby until active primary
appliance encounters an error and is unable to recover.
Provides high availability.

Role-based administration

Role-based administration streamlines how administrators
configure user accounts and control access to the
management console.
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TERMINOLOGY DESCRIPTION

Sandbox image A ready-to-use software package (operating system with
applications) that require no configuration or installation.
Virtual Analyzer supports only image files in the Open Virtual
Appliance (OVA) format.

Sandbox instance Asingle virtual machine based on a sandbox image.

Secondary appliance Clustered appliance that processes submissions allocated by
the active primary appliance for performance improvement.

Standalone appliance Appliance that is not part of any cluster. Clustered appliances
can revert to being standalone appliances by detaching the
appliance fromits cluster.

Threat Connect Correlates suspicious objects detected in your environment
and threat data from the Trend Micro Smart Protection
Network. The resulting intelligence reports enable you to
investigate potential threats and take actions pertinent to
your attack profile.

Virtual Analyzer An isolated virtual environment used to manage and analyze
samples. Virtual Analyzer observes sample behavior and
characteristics, and then assigns a risk level to the sample.

Widget A customizable screen to view targeted, selected data sets.

YARA YARA rules are malware detection patterns that are fully
customizable to identify targeted attacks and security threats
specific to your environment.

About Trend Micro

Trend Micro, a global leader in cybersecurity, is passionate about making the
world safe for exchanging digital information today and in the future.
Artfully applying our XGen™ security strategy, our innovative solutions for
consumers, businesses, and governments deliver connected security for data
centers, cloud workloads, networks, and endpoints.

Optimized for leading environments, including Amazon Web Services,
Microsoft®, and VMware®, our layered solutions enable organizations to
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automate the protection of valuable information from today’s threats. Our
connected threat defense enables seamless sharing of threat intelligence and
provides centralized visibility and investigation to make organizations their
most resilient.

Trend Micro customers include 9 of the top 10 Fortune® Global 500
companies across automotive, banking, healthcare, telecommunications,
and petroleum industries.

With over 6,500 employees in 50 countries and the world’s most advanced
global threat research and intelligence, Trend Micro enables organizations to
secure their connected world. http:/www.trendmicro.com



http://www.trendmicro.com
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Chapter1

Introduction

This chapter introduces Deep Discovery Analyzer 6.9 and the new features in
this release.
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About Deep Discovery Analyzer

Deep Discovery Analyzer is a custom sandbox analysis server that enhances
the targeted attack protection of Trend Micro and third-party security
products. Deep Discovery Analyzer supports out-of-the-box integration with
Trend Micro email and web security products, and can also be used to
augment or centralize the sandbox analysis of other products. The custom
sandboxing environments that can be created within Deep Discovery
Analyzer precisely match target desktop software configurations — resulting
in more accurate detections and fewer false positives.

Deep Discovery Analyzer also provides a Web Services API to allow
integration with any third-party product, and a manual submission feature
for threat research.

What's New

TABLE 1-1. What's New in Deep Discovery Analyzer 6.9

FEATURE/ENHANCEMENT DETAILS

SAML for single sign-on (SSO) | Deep Discovery Analyzer supports the Security Assertion
Markup Language (SAML) authentication standard using Okta
and Active Directory Federation Services (ADFS) identify
providers to allow users to single sign-on to the Deep
Discovery Analyzer console when they sign in to their
organization's portal.

HTTPS certificate Deep Discovery Analyzer supports replacing the HTTPS
replacement certificate for enhanced communication security.
New Trend Micro product Deep Discovery Analyzer supports integration with Trend

integration Micro Web Security.
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FEATURE/ENHANCEMENT

DETAILS

Enhanced Virtual Analyzer

The internal Virtual Analyzer has been enhanced. This release
adds the following features:

Image support for Windows 10 19H1 and 19H2, and
Windows Server 2019

Infection chain graphic for detected malware in analysis
reports

This release also provides enhanced Virtual Analyzer
management to allow you to:

Import images using the Virtual Analyzer image import
tool

Export images

Enhanced detection
capabilities

Deep Discovery Analyzer provides increased protection by
improving its detection capabilities. This release includes the
following features:

New file type (.jar) for enhanced Predictive Machine
Learning integration

YARA rule detection for all file types

Deep Discovery Director
integration

Deep Discovery Analyzer integrates with the cloud version of
Deep Discovery Director.

Enhanced Trend Micro
ActiveUpdate security

Deep Discovery Analyzer provides the following settings to
enhance component update security:

Trend Micro ActiveUpdate server authentication

Package integrity check on component update packages
from other update sources ( including Trend Micro Apex
Central and Trend Micro Update Tool (TMUT))
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FEATURE/ENHANCEMENT DETAILS
Enhanced management The management console has been enhanced to include the
console following:

Detect and enforce default password change for the
default administrator account upon first logon for
account security

YARA rule name search on Submission screens

Refresh function on Submission screens

Inline migration from Deep On hardware versions 1100 and 1200, Deep Discovery Analyzer
Discovery Analyzer 6.5 Patch | can automatically migrate the settings of a Deep Discovery
land 6.8 Analyzer 6.5 Patch 1 and 6.8 installation to 6.9.

Features and Benefits

Deep Discovery Analyzer includes the following features:
+  Enable Sandboxing as a Centralized Service on page 1-5
«  Custom Sandboxing on page 1-5

«  Broad File Analysis Range on page 1-5

« YARA Rules on page 1-5

«  Document Exploit Detection on page 1-5

« Automatic URL Analysis on page 1-6

«  Detailed Reporting on page 1-6

« Alert Notifications on page 1-6

« Clustered Deployment on page 1-6

« Trend Micro Product Integration on page 1-6

« Web Services API and Manual Submission on page 1-6
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Custom Defense Integration on page 1-7

ICAP Integration on page 1-7

Enable Sandboxing as a Centralized Service

Deep Discovery Analyzer ensures optimized performance with a scalable
solution able to keep pace with email, network, endpoint, and any additional
source of samples.

Custom Sandboxing
Deep Discovery Analyzer performs sandbox simulation and analysis in
environments that match the desktop software configurations attackers
expect in your environment and ensures optimal detection with low false-
positive rates.

Broad File Analysis Range
Deep Discovery Analyzer examines a wide range of Windows executable,

Microsoft Office, PDF, web content, and compressed file types using multiple
detection engines and sandboxing.

YARA Rules

Deep Discovery Analyzer uses YARA rules to identify malware. YARA rules
are malware detection patterns that are fully customizable to identify
targeted attacks and security threats specific to your environment.

Document Exploit Detection

Using specialized detection and sandboxing, Deep Discovery Analyzer
discovers malware and exploits that are often delivered in common office
documents and other file formats.
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Automatic URL Analysis
Deep Discovery Analyzer performs page scanning and sandbox analysis of
URLs that are automatically submitted by integrating products.

Detailed Reporting
Deep Discovery Analyzer delivers full analysis results including detailed
sample activities and C&C communications via central dashboards and
reports.

Alert Notifications
Alert notifications provide immediate intelligence about the state of Deep
Discovery Analyzer.

Clustered Deployment
Multiple standalone Deep Discovery Analyzer appliances can be deployed
and configured to form a cluster that provides fault tolerance, improved
performance, or a combination thereof.

Trend Micro Product Integration
Deep Discovery Analyzer enables out-of-the-box integration to expand the

sandboxing capacity of Trend Micro email and web security products.

Web Services APl and Manual Submission

Deep Discovery Analyzer allows any security product or authorized threat
researcher to submit samples.
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Custom Defense Integration

Deep Discovery Analyzer shares new IOC detection intelligence
automatically with other Trend Micro solutions and third-party security
products.

ICAP Integration

Deep Discovery Analyzer supports integration with Internet Content
Adaptation Protocol (ICAP) clients. After integration, Deep Discovery
Analyzer can perform the following functions:

Work as an ICAP server that analyzes samples submitted by ICAP clients

Serve User Configuration Pages to the end user when the specified
network behavior (URL access / file upload / file download) is blocked

Control which ICAP clients can submit samples by configuring the ICAP
Client list

Bypass file scanning based on selected MIME content-types
Bypass file scanning based on true file types
Bypass URL scanning in RESPMOD mode

Scan samples using different scanning modules

Filter sample submissions based on the file types that Virtual Analyzer
can process.
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Chapter 2

Getting Started

This chapter describes how to get started with Deep Discovery Analyzer and
configure initial settings.
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The Preconfiguration Console

The preconfiguration console is a Bash-based (Unix shell) interface used to
configure network settings, view high availability details, ping remote hosts,
and change the preconfiguration console password.

For details, see the Deep Discovery Analyzer Installation and Deployment Guide.

The Management Console

Deep Discovery Analyzer provides a built-in management console that you
can use to configure and manage the product.

Open the management console from any computer on the management
network using one of the following web browsers:

Microsoft Internet Explorer™ 10 or 11
Microsoft Edge™
Google Chrome™

Mozilla Firefox™

ﬁ Note

Make sure Javascript is enabled in the web browser.

To log on, open a browser window and type the following URL:
https://<Appliance IP Address>/pages/login.php

You can log on to the Deep Discovery Analyzer management console using
one of the following methods:

Logging On Using Local Accounts on page 2-3

Logging On With Single Sign-On on page 2-4
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Logging On Using Local Accounts

Procedure

1.

On the Log On screen, type the logon credentials (user name and
password) for the management console.

Use the default administrator logon credentials when logging on for the
first time:

. User name: admin

. Password: Admin1234!

ﬁ’ Note

Depending on your account, provide one of the following information in
the User name field:

User name
UPN

. Email address

(Optional) Select Enable extended session timeout to apply the
extended session timeout for your logon session. The default session
timeout is 10 minutes.

To change the session timeout settings, navigate to Administration >
System Settings and click the Session Timeout tab.

Click Log On.

If this is the first time you log on using the "admin" account with the
default password, change the account password before you can access
the management console.
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Logging On With Single Sign-On

If you configure the required settings for SAML integration on Deep
Discovery Analyzer, users can access the Deep Discovery Analyzer
management console using their existing identity provider credentials.

For more information, see SAML Authentication Tab on page 6-29.

Procedure
1. Onthe Log On screen, select a service name from the drop-down list.
2. Click Single Sign-on (SSO).

The system automatically navigates to the logon page for your
organization.

3. Follow the on-screen instructions and provide your account credentials
to access the Deep Discovery Analyzer management console.

Management Console Navigation

The management console consists of the following elements:

TABLE 2-1. Management Console Elements

SECTION DETAILS

Banner The management console banner contains:

Product logo and name: Click to go to the dashboard. For details,
see Dashboard Overview on page 3-2.

Name of the user currently logged on to the management
console.

Log Off link: Click to end the current console session and return
to the logon screen.

System time: Displays the current system time and time zone.
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SECTION DETAILS

Main Menu Bar The main menu bar contains several menu items that allow you to

configure product settings. For some menu items, such as Dashboard,
clicking the item opens the corresponding screen. For other menu
items, submenu items appear when you click or mouseover the menu
item. Clicking a submenu item opens the corresponding screen.

ScrollUp and Arrow | Use the Scroll up option when a screen’s content exceeds the
Buttons available screen space. Next to the Scroll up button is an arrow button

that expands or collapses the bar at the bottom of the screen.

Context-sensitive Use Help to find more information about the screen that is currently
Help displayed.

Getting Started Tasks

Procedure

1. Activate the product license using a valid Activation Code. For details,
see License on page 6-98.

2. Specify the Deep Discovery Analyzer host name and IP address. For
details, see Network Tab on page 6-42.

3. Configure proxy settings if Deep Discovery Analyzer connects to the
management network or Internet through a proxy server. For details,
see Proxy Tab on page 6-44.

4. Configure date and time settings to ensure that Deep Discovery Analyzer
features operate as intended. For details, see Time Tab on page 6-47.

5. Configure SMTP settings to enable sending of notifications through
email. For details, see SMTP Tab on page 6-45.

6. Import sandbox instances to Virtual Analyzer. For details, see Importing
an Image on page 4-50.

7. Configure Virtual Analyzer network settings to enable sandbox instances

to connect to external destinations. For details, see Enabling External
Connections on page 4-71.
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8. (Optional) Deploy and configure additional Deep Discovery Analyzer
appliances for use in a high availability or load-balancing cluster. For
details, see Cluster Tab on page 6-56.

9. Configure supported Trend Micro products for integration with Deep
Discovery Analyzer. For details, see Integration with Trend Micro Products
on page 2-6.

10. Adjust Virtual Analyzer resource allocation between all sources by
assigning weight and timeout values to all sources that submit objects to
Deep Discovery Analyzer for analysis. For details, see Submitters on page
4-75.

Integration with Trend Micro Products

Deep Discovery Analyzer integrates with the following Trend Micro
products.
Sandbox Analysis

Products that can send samples to Deep Discovery Analyzer for sandbox
analysis:

ﬁ Note

All samples display on the Deep Discovery Analyzer management console, on
the Submissions screen (Virtual Analyzer > Submissions). Deep Discovery
Analyzer administrators and investigators can also manually send samples
from this screen.

Apex One as a Service
Apex One 2019

Deep Discovery Email Inspector 2.5 or later
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Deep Discovery Inspector 3.7 or later

Deep Discovery Web Inspector 2.5

ScanMail for Microsoft Exchange 11.0 or later

ScanMail for IBM Domino 5.6 SP1 Patch 1 HF4666 or later
InterScan Messaging Security Virtual Appliance (IMSVA) 8.2 SP2 or later
InterScan Messaging Security Suite (IMSS) for Windows 7.5 or later
InterScan Web Security Virtual Appliance (IWSVA) 6.0 or later
InterScan Web Security Suite (IWSS) 6.5

InterScan Messaging Security Suite (IMSS) for Linux 9.1

Deep Security 10.0 or later

Deep Edge 2.5 SP2 or later

OfficeScan XG or later

Trend Micro Endpoint Sensor 1.6 or later

Trend Micro TippingPoint Security Management System 5.0 or later
Trend Micro Web Security 3.1

On the management console of the integrating product, go to the appropriate
screen (see the product documentation for details on which screen to access)
and specify the following information:

API key. This is available on the Deep Discovery Analyzer management
console, in Help > About.

Deep Discovery Analyzer IP address. If unsure of the IP address, check
the URL used to access the Deep Discovery Analyzer management
console. The IP address is part of the URL.

Deep Discovery Analyzer IPv4 or IPv6 virtual address. When using Deep
Discovery Analyzer in a high availability configuration, the virtual IP
address is used to provide integrating products with a fixed IP address
for configuration. This is available on the Deep Discovery Analyzer
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management console, in Administration > System Settings > High
Availability.

Deep Discovery Analyzer SSL port 443. This is not configurable.

O Important
&

If the Deep Discovery Analyzer API key changes after registering with the
integrated product, remove Deep Discovery Analyzer from the integrated
product and add it again.

ﬁ Note

Some integrating products require additional configuration to integrate with
Deep Discovery Analyzer properly. See the product documentation for details.

(Optional) On the Deep Discovery Analyzer management console, review and
modify the weight values of integrated products to adjust Virtual Analyzer
resource allocation. For details, see Submitters on page 4-75.

Suspicious Objects List

Products that retrieve the suspicious objects list from Deep Discovery
Analyzer:

Apex Central 2019

Deep Discovery Email Inspector 2.5 or later

Deep Discovery Inspector 3.7 or later

Deep Discovery Web Inspector 2.5

Standalone Smart Protection Server with the latest patch 2.6 or later

OfficeScan Integrated Smart Protection Server 10.6 SP2 Patch 1 to
OfficeScan Integrated Smart Protection Server 11 SP1

InterScan Web Security Virtual Appliance (IWSVA) 6.0 or later
InterScan Web Security Suite (IWSS) 6.5
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Control Manager 7.0 Patch 1 (with the latest hotfix installed)
Trend Micro Web Security 3.1

On the management console of the integrating product, go to the appropriate
screen (see the product documentation for information on which screen to
access) and specify the following information:

API key. This is available on the Deep Discovery Analyzer management
console, in Help > About.

Deep Discovery Analyzer IPv4 or IPv6 address. If unsure of the IP
address, check the URL used to access the Deep Discovery Analyzer
management console. The IP address is part of the URL.

Deep Discovery Analyzer IPv4 or IPv6 virtual address. When using Deep
Discovery Analyzer in a high availability configuration, the virtual IP
address is used to provide integrated products with a fixed IP address for
configuration. This is available on the Deep Discovery Analyzer
management console, in Administration > System Settings > High
Availability.

Deep Discovery Analyzer SSL port 443. This is not configurable.

Deep Discovery Analyzer user logon credentials. For details, see
Accounts Tab on page 6-77.

Q Important
L.

If the Deep Discovery Analyzer API key changes after registering with the
integrated product, remove Deep Discovery Analyzer from the integrated
product and add it again.

ﬁ Note

Some integrating products require additional configuration to integrate with
Deep Discovery Analyzer properly. See the product documentation for details.
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Exceptions

Products that send exceptions to Deep Discovery Analyzer:
Apex Central 8.0 Patch 1
Control Manager 7.0 Patch 1 (with the latest hotfix installed)

On the management console of the integrating product, go to the appropriate
screen (see the product documentation for information on which screen to
access) and specify the following information:

Deep Discovery Analyzer IPv4 or IPv6 address. If unsure of the IP
address, check the URL used to access the Deep Discovery Analyzer
management console. The IP address is part of the URL.

Deep Discovery Analyzer IPv4 or IPv6 virtual address. When using Deep
Discovery Analyzer in a high availability configuration, the virtual IP
address is used to provide integrated products with a fixed IP address for
configuration. This is available on the Deep Discovery Analyzer
management console, in Administration > System Settings > High
Availability.

Deep Discovery Analyzer SSL port 443. This is not configurable.

Deep Discovery Analyzer user logon credentials. For details, see
Accounts Tab on page 6-77.

Important

If the Deep Discovery Analyzer API key changes after registering with the
integrated product, then Deep Discovery Analyzer will need to be deleted from
the integrated product and added again.

ﬁ Note

Some integrating products require additional configuration to integrate with
Deep Discovery Analyzer properly. See the product documentation for details.
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Chapter 3

Dashboard

This chapter describes the Deep Discovery Analyzer dashboard.
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Dashboard Overview

Monitor your network integrity with the dashboard. Each management
console user account has an independent dashboard. Changes made to one
user account dashboard do not affect other user account dashboards.

The dashboard consists of the following user interface elements:

“ou are here: Dashboard i
i
o I {
[ Tab Seﬂingslj Add Widgetsl}
Widget Title T Widget Title v i
f
L
1
4
if
{
1
ELEMENT DESCRIPTION
Tabs Tabs provide a container for widgets.
For details, see Tabs on page 3-3.
Widgets Widgets represent the core dashboard components.
For details, see Widgets on page 3-5.




Dashboard

ﬁ Note

The Add Widget button appears with a star when a new widget is available.

Click Play Tab Slide Show to show a dashboard slide show.

Tabs

Tabs provide a container for widgets. Each tab on the dashboard can hold up
to 20 widgets. The dashboard supports up to 30 tabs.

Tab Tasks

KR -

[ Tab settings
The following table lists all the tab-related tasks:
TAsK STEPS
Add a tab Click the plusicon ( + |) on top of the dashboard. The New Tab

window displays.

For details, see New Tab Window on page 3-4.

Edit a tab's settings Click Tab Settings. A window similar to the New Tab window
opens, where you can edit settings.

Move a tab Use drag-and-drop to change a tab’s position.

Delete a tab Click the delete icon ([Z]) next to the tab title. Deleting a tab also

deletes all the widgets in the tab.
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New Tab Window

The New Tab window opens when you click the plus icon (- ) on top of the
dashboard.

This window includes the following options:

New Tab
Title:
Layout: o —
J_ﬂ [ | (| (1]
L1 1 L
j_u_ﬂ [ | | ([ 1] HEN
NN | | |
ﬂﬂﬂﬂ L __ | o000 © |O0oo
il L | 1]
Slide Show: ¥ Include this tab in the slide show
Duration: |10 | seconds.
Auto-fit: (i) * 0on Off
Save | [ Cancel
TABLE 3-1. New Tab Tasks
TASK STEPS
Title Type the name of the tab.
Layout Choose from the available layouts.
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TAsSK STEPS
Slide Show Select to include the tab in the Dashboard slide show.
Duration Type the number of seconds to display the tab during the Dashboard
slide show.
Auto-fit Choose On or Off. This feature works when there is only one widget in
a column. Choose On to adjust the height of the single widget to
match the highest column.

Widgets

Widgets are the core components of the dashboard. Widgets contain charts
and graphs that allow you to monitor the system status and track threats.

Widget Tasks

All widgets follow a widget framework and offer similar task options.

[E3 Tab Settings Add Widgets

Widget Title LR

Lastrefreshed | (0 Refresh Settings
Pericd: | Last 24 hours ¥
? Help

# Close Widget

m|
-

|
|
|
|
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TASK STEPS
Add a widget Open a tab and then click Add Widgets at the top right corner of
the tab. The Add Widgets screen displays. For details, see Adding
Widgets to the Dashboard on page 3-7.
Refresh widget data Click the refresh icon (%) to refresh widget data.

Click the refresh settings icon (()) to set the frequency that the
widget refreshes or to automatically refresh widget data.

Delete a widget

Click the delete icon (£) to close the widget. This action removes
the widget from the tab that contains it, but not from any other
tabs that contain it or from the widget list in the Add Widgets
screen.

Change period If available, click the Period drop-down menu to select the time
period.
Change the node If available, click the Node drop-down box on top of the widget to

change the node.

Move a widget within the
same tab

Use drag-and-drop to move the widget to a different location
within the tab.
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TASK

STEPS

Resize a widget

Point the cursor to the widget's right edge to resize a widget. When
you see a thick vertical line and an arrow (as shown in the
following image), hold and then move the cursor to the left or
right.

vzer Statistics

t 24 Hours %

You can resize any widget within a multi-column tab (red squares).
These tabs have any of the following layouts.

el

L1
LLL]

i

Adding Widgets to the Dashboard

The Add Widgets screen appears when you add widgets from a tab on the

dashboard.

Do any of the following:

Procedure

«  Toreduce the widgets that appear, click a category from the left side.
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To search for a widget, specify the widget name in the search text box at
the top.

To change the widget count per page, select a number from the Records
drop-down menu.

To switch between the Detailed and Summary views, click the display
icons ([=]z=]) at the top right.

To select the widget to add to the dashboard, select the check box next to
the widget's title.

To add the selected widgets, click Add.

Summary Tab

View the Summary tab widgets to understand threats detected by Deep
Discovery Analyzer based on type and amount, the volume of suspicious
objects discovered during analysis, submissions over time, and the Virtual
Analyzer summary.
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Threat Types

This widget shows the type, amount, and risk level of threats detected in all
submissions during the specified time period.

Threat Types -

Period: | Last 24 hours ¥ Last refresh: 22/06/2018 14:10:17
Threat Type High Risk Medium Risk Low Risk Total

Ransomware 4 0 0 4
47" Coin Miner 0 0 0 0
ﬁ Dropper 62 1] 17 179
& Worm 35 0 0 35
Backdoor 22 0 &9 o7
& Bot 13 0 o 13
EE  Kevlogaoer 5 0 0 5
Downloader 3 0 0 3
5 File infector 0 0 ] 0
% Exploit 0 0 0 0
£ Rootkit 0 0 0 0

The default period is Last 24 hours. Change the period according to your
preference.

Click a number under High Risk, Medium Risk, Low Risk, or Total to go to
the Submissions screen and view detailed information.
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Suspicious Objects

This widget plots the number of objects (IP addresses, domains, URLs, and
files) added to the Suspicious Objects list during the specified time period.

Suspicious Objects =
Period: | Last 90 days ¥ Last refresh: 2017-11-08 17:35:44
View suspicious objects

15

10

5

2017-08-11 2017-09-04 2017-09-25 2017-10-16 2017-11-08

| IP addresses [ Domains [ urLs [ Files |

The default period is Last 24 hours. Change the period according to your
preference.

Click View suspicious objects to go to the Suspicious Objects screen and
view detailed information.

For details, see Suspicious Objects on page 4-37.
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Submissions Over Time

This widget plots the number of samples submitted to Virtual Analyzer over
a period of time.

Submissions Over Time x5 -
Period; | Last 20 days ¥ Last refresh: 2017-11-08 17:40:44
View submissions
1500
1074
1000
500

0 1 0
T

2017-08-13 2017-08-03 2017-09-24 2017-10-15 2017-11-05
| I High risk I Medium risk Low risk [ Mo risk I Mot analyzed |

The default period is Last 24 hours. Change the period according to your
preference.

Click View submissions to go to the Submissions screen and view detailed
information.

For details, see Submissions on page 4-3.
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Virtual Analyzer Summary

This widget shows the total number of samples submitted to Virtual Analyzer
and the number of these samples with risk.

Virtual Analyzer Summary x5 -

Period: | Last 90 days ¥ Last refresh: 2017-11-08 17:40.44

Statistics Malicious Events
Distribution

[=2]

Submissions 142
Identified risks
M High risk

B Medium risk

=] =] Ira [ 8] ‘

[ Low risk

% of submissions that are risks 0.14 100.00%

The default period is Last 24 hours. Change the period according to your
preference.

Click the total number of submissions or the number of submissions with
High risk, Medium risk, or Low risk to go to the Submissions screen and
view detailed information.

For details, see Submissions on page 4-3.
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System Status Tab

View the widgets in the System Status tab to understand the overall
performance of Deep Discovery Analyzer based on Virtual Analyzer status,
queued samples, and the hardware status.

Virtual Analyzer Status

This widget displays the status of Virtual Analyzer on one or all nodes, and
the number of instances for each image.

Depending on the node type, the widget content includes one of the
following:

Single node or all nodes in a cluster: The number of queued and
processing samples

Primary or secondary node in a cluster: The number of URLs in pre-
Virtual Analyzer processing queue and the number of samples the
Virtual Analyzer is processing

ﬁ Note

The Node drop-down list is not available when you deploy Deep Discovery
Analyzer as a standalone appliance.

If Deep Discovery Analyzer is the primary appliance in a cluster or ICAP
integration is enabled, the number of Virtual Analyzer (VA) instances
displayed might not be equal to the number of Virtual Analyzer instances
configured.

To view the number of Virtual Analyzer instances configured, see Images
Tab on page 4-49.
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Yirual Analyzer Status

2 v

Mode: | All v

Normal status on all nodes
Image

T

All Images

Checked every & minutes

27986

Instances
79
79

Last refresh: 27/09/2019 15:34:52

Manage Virtual Analyzer

processing
queued samples 2140 e
o 0 Utilization

79 0 0%

79 0 0%

Click Manage Virtual Analyzer to go to the Sandbox Management screen.
For details, see Sandbox Management on page 4-47.

Normal status on all nodes indicates all nodes are operating without errors.

If the status shows an error on one or more nodes, go to Administration >
System Settings and click the Cluster tab to view detailed information about
the error.
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Queued Samples

This widget displays the number of queued samples in Virtual Analyzer. The
red line indicates the estimated number of samples Virtual Analyzer can
analyze within 5 minutes.

Queued Samples b= 4
0 queued samples Last refresh: 2017-11-08 17:40:37
View queue

15

10

5 4 samples

o - i i i ——
-120 minutes -50 minutes -60 minutes -30 minutes

| B Files B URLs |

Checked every 5 minuies

Click View queue to go to the Queued tab in the Submissions screen and
view detailed information.

For details, see Submissions on page 4-3.
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Hardware Status

This widget displays the real-time utilization of key hardware components.

Hardware Status L/

Last refresh: 2017-11-07 20:12:35

100 %
CPU
——n—r-—ﬂ_——/\—-_——_ﬂ_-'.‘-‘_—_f‘-_wf“_‘-ﬁ-————-—-

7472 MB
Memory

Disk 1/0 EILE
—Read

—Wirite

e

Disk Space NG
103.86 GB free of 123.90 GB

Checked every 10 seconds
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Average Virtual Analyzer Processing Time

This widget shows the average processing time used by Virtual Analyzer for

the specified period.

Average Virtual Analyzer Processing Time TR
Period: | Last 80 days ¥ Last refresh: 2017-11-08 16:38:15
Manage Virual Analvzer

150 sec

100 sec

50 zec

0 sec -
2017-08-11 2017-09-04 2017-09-25 2017-10-18 2017-11-08
| -~ VA analysis time —#- Total processing time |

This widget compares the following data:

VA analysis time: average time spent by samples inside Virtual Analyzer,
from start to completion of the Virtual Analyzer analysis process

Total processing time: average total time spent by samples inside Deep
Discovery Analyzer, from the time Deep Discovery Analyzer receives the
sample to the time Deep Discovery Analyzer generates the final analysis
result

The default period is Last 4 hours. Change the period according to your
preference.

Click Manage Virtual Analyzer to go to the Images Tab screen.
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For details, see Images Tab on page 4-49.
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Chapter 4

Virtual Analyzer

This chapter describes the Virtual Analyzer.
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Virtual Analyzer

Virtual Analyzer is a secure virtual environment that manages and analyzes
objects submitted by integrated products, administrators, and investigators.
Custom sandbox images enable observation of files, URLs, registry entries,
API calls, and other objects in environments that match your system
configuration.

Virtual Analyzer performs static and dynamic analysis to identify an object's
notable characteristics in the following categories:

+  Anti-security and self-preservation

« Autostart or other system configuration

- Deception and social engineering

«  File drop, download, sharing, or replication

+  Hijack, redirection, or data theft

«  Malformed, defective, or with known malware traits
«  Process, service, or memory object change

+  Rootkit, cloaking

- Suspicious network or messaging activity

During analysis, Virtual Analyzer rates the characteristics in context and
then assigns a risk level to the object based on the accumulated ratings.
Virtual Analyzer also generates analysis reports, suspicious object lists, PCAP
files, and OpenlOC files that can be used in investigations.

It works in conjunction with Threat Connect, the Trend Micro service that
correlates suspicious objects detected in your environment and threat data
from the Smart Protection Network.
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Submissions

The Submissions screen, in Virtual Analyzer > Submissions, includes a list
of samples processed by Virtual Analyzer. Samples are files and URLs
submitted automatically by integrated products or manually by Deep
Discovery Analyzer administrators or investigators.

The Submissions screen organizes samples into the following tabs:
Completed: Samples that Virtual Analyzer has analyzed
Processing: Samples that Virtual Analyzer is currently analyzing
Queued: Samples that are pending analysis

Unsuccessful: Samples that have gone through the analysis process but
do not have analysis results due to errors

ﬁ Note

Samples listed on the Unsuccessful tab are not included in the sample
count displayed on a widget.

ICAP Pre-scan: High-risk samples received from integrated ICAP clients.

Each tab displays a table summarizing basic information about the
submitted samples. To customize which columns appear in the table, click
the gear icon (i3 ), select the columns to be displayed in the table, and click

Apply.
To update the data displayed in the table, click Refresh.

The following table outlines all available columns. Column display varies
depending on the tab you select.

TABLE 4-1. Submission columns

COLUMN INFORMATION

Object Information
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COLUMN INFORMATION
Submitted Date and time when the sample was submitted
This column is available on the Completed, Processing, Queued and
Unsuccessful tabs only.
File Name This field displays one of the following information:

File name of the sample
File name of the child object with the highest risk level

File name of any child object if no risk is detected

Note
"NONAMEFL" if file size is 0 or too small for analysis

Sample Package

Archived copy of the file sample

ﬁ’ Note

Downloads are only available for file submissions. Click to
download the file sample as an archived file. The archive password
isvirus.

This column is available on the Unsuccessful tab only.

Submitter

Name of the Trend Micro product that submitted the sample
"Manual Submission" if manually submitted
"ICAP Client" if sample originated from an ICAP client

This column is available on the Completed, Processing, Queued and
Unsuccessful tabs only.

Submitter Name

Host name of the product that submitted the sample
No data (indicated by a dash) if manually submitted

IP address of the ICAP clients

SHA-1

SHA-1 value of the sample
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COLUMN INFORMATION

SHA-256 SHA-256 value of the sample

This column is available on the Completed and ICAP Pre-scantabs only.

Object Type File ora URL

This column is available on the Completed, Processing, Queued and
Unsuccessful tabs only.

Detected Date and time when the sample was detected

This column is available on the ICAP Pre-scan tab only.

ICAP Mode Mode reported by the ICAP client when the sample was detected
Possible values are:

REQMOD: ICAP Request modification method

RESPMOD: ICAP Response modification method

This column is available on the ICAP Pre-scan tab only.

Analysis Information
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COLUMN INFORMATION

Risk Level Virtual Analyzer performs static analysis and behavior simulation to
identify a sample's characteristics. During analysis, Virtual Analyzer rates
the characteristics in context and then assigns a risk level to the sample
based on the accumulated ratings.

Red icon ({3): High risk. The object exhibited highly suspicious
characteristics that are commonly associated with malware.

Examples:
Malware signatures; known exploit code
Disabling of security software agents
Connection to malicious network destinations
Self-replication; infection of other files
Dropping or downloading of executable files by documents

Yellow icon (| " ): Low risk. The object exhibited mildly suspicious
characteristics that are most likely benign.

Green icon (Q): No risk. The object did not exhibit suspicious
characteristics.

Gray icon (- ): Not analyzed

For possible reasons why Virtual Analyzer did not analyze afile, see
Possible Reasons for Analysis Failure on page 4-34.

ﬁ’ Note

If several instances processed a sample, the icon for the most
severe risk level displays. For example, if the risk level on one
instance is yellow and then red on another, the red icon displays.
Mouseover the icon for details about the risk level.

This column is available on the Completed tab only.

Completed Date and time that sample analysis was completed

This column is available on the Completed tab only.
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COLUMN INFORMATION

File Type . File type of the object
File type of the archive / File type of the highest risk child object
File type of the archive / File type of any child object if no risk

Note

"Empty" or "UNKNOWN" if file size is 0 or too small to identify file
type for analysis

This column is available on the Completed and ICAP Pre-scan tabs only.

Threat Name of threat as detected by Trend Micro pattern files and other
components

This column is available on the Completed and ICAP Pre-scan tabs only.

ﬁ’ Note

For the ICAP Pre-scan tab, if the threat name is not available (e.g.
the Web Inspection Service doesn't provide a threat name for a
URL), "Undefined threat" is displayed.

Threat Types Type of threat as detected by Trend Micro pattern files and other
components

This column is available on the Completed tab only.

Elapsed Time The amount of time that has passed since processing started

This column is available on the Processing tab only.

Processed By IP address of the node that is processing the object, if Deep Discovery
Analyzer is configured in a load-balancing cluster

This column is available on the Completed and Processing tabs only.

Priority Priority assigned to the sample

This column is available on the Queued tab only.
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COLUMN

INFORMATION

Time in Queue

The amount of time that has passed since Virtual Analyzer added the
sample to the queue

This column is available on the Queued tab only.

Error

Reason for analysis failure

This column is available on the Unsuccessful tab only.

Child Files

The number of child files detected in the sample

You can click the number to view detailed child file detection information.
For more information, see Viewing Child File Detection Information on page
4-30.

This column is available on the ICAP Pre-scan tab only.

Identified By

The name of the detection module that processed the object

This column is available on the ICAP Pre-scan tab only.

YARA Rule File

Name of the YARA rule file that contains the matched YARA rule

If a child file is detected, you can click the link to view detailed YARA
detection information.

This column is available on the Completed tab only.

ﬁ Note
- Ifamatchis found for a child file but not the parent file, this
field displays the name of any YARA rule file that contains the
matched YARA rule.

If a match is found for a parent file or a file without any child
file, this field displays the name of the YARA rule file that
contains the matched YARA rule.

YARA Rule Name

Name of the matched YARA rule.

This column is available on the Completed and ICAP Pre-scan tabs.

Event Information
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COLUMN INFORMATION

Event Logged . For samples submitted by other Trend Micro products, the date and
time the product dispatched the sample

For manually submitted samples and for samples submitted by ICAP
clients, the date and time Deep Discovery Analyzer received the
sample

Source / Sender Where the sample originated
IP address for network traffic or email address for email

No data (indicated by a dash) if manually submitted

Destination / Where the sample is sent

Recipient . . .
IP address for network traffic or email address for email

No data (indicated by a dash) if manually submitted

Protocol . Protocol used for sending the sample, such as SMTP for email or
HTTP for network traffic

No data (indicated by a dash) if manually submitted

This column is available on the Completed, Processing, Queued and
Unsuccessful tabs only.

URL URL of the sample

ﬁ’ Note

Deep Discovery Analyzer may have normalized the URL when
submitted using the management console.

Email Subject Email subject of the sample

This column is available on the Completed, Processing, Queued and
Unsuccessful tabs only.

Message ID Message ID of the sample

This column is available on the Completed, Processing, Queued and
Unsuccessful tabs only.
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COLUMN INFORMATION

Source IP IP address where the sample originated, , based on the X-Client-IP ICAP
header sent by the ICAP client

This column is available on the ICAP Pre-scan tab only.

Destination IP IP address where the sample was sent, based on the X-Server-IP ICAP
header sent by the ICAP client

This column is available on the ICAP Pre-scan tab only.

Source User User currently logged on when the sample was found, based on the X-
Authenticated-User ICAP header sent by the ICAP client

This column is available on the ICAP Pre-scan tab only.

Threat Connect Displays a link to Threat Connect

This column is available on the ICAP Pre-scan tab only.

ICAP Submissions

Deep Discovery Analyzer supports integration with Internet Content
Adaptation Protocol (ICAP) clients.

ICAP Pre-scans

When ICAP clients send samples to Deep Discovery Analyzer for analysis,
Deep Discovery Analyzer performs a pre-scan which compares samples
received with known existing threats using the following resources:

+ Advanced Threat Scan Engine (ATSE) for file scans

+ YARArules

+  Suspicious objects and user-defined suspicious objects lists
«  Predictive Machine Learning engine

+ Web Reputation Services (WRS) for URL scans
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- Deep Discovery Analyzer cache

Depending on the result of the pre-scan, Deep Discovery Analyzer performs
the following actions.

RESULT ACTION
If the sampleis a . Deep Discovery Analyzer sends the original request as a response
known good file / back to the ICAP client.
URL
If the sample does . Deep Discovery Analyzer sends the original request as a response
not match any back to the ICAP client.

existing record . e
Deep Discovery Analyzer treats the sample as a submission and

sends it to the Submission queue. The sample is not shown on
the ICAP Pre-scan tab.

Deep Discovery Analyzer adds the sample to the Deep Discovery
Analyzer database to benefit later submissions.

ﬁ’ Note

If Virtual Analyzer does not support the file type of a submitted
sample, Deep Discovery Analyzer does not send the sample to
the Submission queue or add to the Deep Discovery Analyzer

database.
If the sample - Deep Discovery Analyzer reponds with a 403 Forbidden
matches a known message to the ICAP client.

malicious threat . .
Deep Discovery Analyzer logs the sample and displays sample

details on the ICAP Pre-scan tab.

ﬁ Note

To view the ICAP Pre-scan tab on the Submissions screen, enable the setting in
Administration > Integrated Products/Services > ICAP. This tab is hidden by
default.

For details, see ICAP Tab on page 6-23.




Deep Discovery Analyzer 6.9 Administrator's Guide

ICAP Header Responses

For each sample submitted by ICAP clients, Deep Discovery Analyzer returns
ICAP headers.

The following shows an example.

ICAP/1.0 200 OK

Server: Deep Discovery Analyzer 6.8 Build 1165

ISTag: "12.300.1011"

X=Virus-ID: TROJ_FRS.ONA103DD20,TROJ_FRS.ONA104DD20
X-Infection-Found: Type=0; Resolution=2; Threat=TROJ_FRS.ONA103
DD20,TROJ_FRS.ONA104DD20;

X-Response-Desc: URL: No risk rating from WRS; FILE: Detected b
y ATSE

Encapsulated: res-hdr=0, res-body=86

Date: Thu, 16 Apr 2020 07:38:01 GMT

The following table describes the ICAP headers.

ICAP
VALUES EXAMPLES
HEADERS
ICAP/1.0 ICAP status code. ICAP 1.0 200 OK
For example: ICAP 1.0 204 No

. Content
204: If an ICAP client accepts the 204 status code

with cached content
200:

If an ICAP client does not accept the 204
status code

Content is too big for an ICAP client to store
in the cache. Deep Discovery Analyzer will
return 200 OK with the HTTP content.

Athreat is detected. Deep Discovery
Analyzer will return 200 0K with the ICAP
header and HTTP 403 Forbidden

For more information on the status codes, see the RFC
documentation.
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ICAP
VALUES EXAMPLES
HEADERS

Server Deep Discovery Analyzer version and build number Server: Deep
Discovery Analyzer
6.8 Build 1165

ISTag Version of the Advanced Threat Scan Engine for Deep | ISTag:

Discovery (Linux, 64-bit) component "12.300.1011"

This is used to validate that previous Deep Discovery
Analyzer responses can still be considered fresh by an
ICAP client that may still be caching them.

Encapsulated

The offset of each encapsulated section's start relative
to the start of the encapsulating message's body

Encapsulated: req-
hdr=0, req-body=86

Date

The date time value provided by the Deep Discovery
Analyzer clock, specified as an RFC 1123 compliant
date/time string

Date: Thu, 16 Apr
2020 07:38:01 GMT

For more details about ICAP headers, refer to the following site:

http://www.icap-forum.org/

The following table describes the additional headers that Deep Discovery
Analyzer returns.

ﬁ Note

If enabled, Deep Discovery Analyzer always returns the X-Response-Desc
header, and only returns the X-Virus-ID and X-Infection-Found headers when a
known threat is detected during the pre-scanning of samples received from
ICAP clients.

ICAP HEADERS

VALUES

EXAMPLES

X-Virus-1D

One line of US-ASCII text with the
name of the virus or risk
encountered

X-Virus-ID: TSPY_ONLINEG.MCS
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ICAP HEADERS VALUES EXAMPLES
X-Infection- Numeric code for the type of X-Infection-Found: Type=0;
Found infection, the resolution, and the | Resolution=2;
risk description Threat=TSPY_ONLINEG.MCS;
X-Response- Reason Deep Discovery Analyzer | X-Response-Desc: URL: No risk rating
Desc considers a URL or file sample as | from WRS; FILE: Detected by ATSE
malicious or safe

ﬁ Note

To enable these headers and configure other ICAP settings, go to
Administration > Integrated Products/Services > ICAP.

For details, see Configuring ICAP Settings on page 6-24.

The X-Response-Desc header varies based on the pre-scan result. The
following tables describes the X-Response-Desc headers.

TABLE 4-2. X-Response-Desc headers: URL

X-RESPONSE-DESC HEADER DESCRIPTION

No risk rating from WRS The URL is detected by Web Reputation Services (WRS) and is
considered as safe.

Match found in URL exception | The URL matches an entry in the exception list and is

list displayed on the Exceptions screen.

No risk rating from VA The URL is detected by Virtual Analyzer is considered as safe.
Bypass URL scanningin If you select Bypass URL scanning in RESPMOD mode on the
RESPMOD mode ICAP screen, Deep Discovery Analyzer does not scan URLs in

RESPMOD mode.

Invalid URL The URL is detected with an invalid format.

Unable to analyze URL in VA The URL is not supported in Virtual Analyzer.

Detected by WRS The URL is detected by WRS and is considered as malicious.
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X-RESPONSE-DESC HEADER

DESCRIPTION

Detected by suspicious
objects list

The URL matches an entry in the suspicious objects list.

Detected by user-defined
suspicious objects list

The URL matches an entry in the user-defined suspicious
objects list.

Detected by VA cache

The URL is already analyzed by Virtual Analyzer and is
considered as malicious.

URL submitted to VA

No pre-scan result is available for the URL. Submit the URL
sample to Virtual Analyzer for analysis.

TABLE 4-3. X-Response-Desc headers: File

X-RESPONSE-DESC HEADER

DESCRIPTION

Match found in file exception
list

The file matches an entry in the exception list and is displayed
on the Exceptions screen.

No risk rating from VA

The file is detected by Virtual Analyzer is considered as safe.

Unsupported file type in VA

The file is not analyzed by Virtual Analyzer due to one of the
following:

The file type is not supported in Virtual Analyzer

For more information on supported file types, see
Submission Settings Tab on page 4-61.

The file is password protected and cannot be extracted by
Virtual Analyzer for analysis

Other reasons that Virtual Analyzer is unable to perform
the file analysis

Bypass MIME content-type
scanning

If you select Enable MIME content-type exclusion and the
content-type is in the exclusion list, Deep Discovery Analyzer
does not scan the file.

Maximum file size exceeded

The file size has exceeded the maximum (60MB).

Bypass true file type scanning

If you select Enable MIME content-type validation and the
file type is in the exclusion list, Deep Discovery Analyzer does
not scan the file.
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X-RESPONSE-DESC HEADER DESCRIPTION

Detected by ATSE The file is detected by Advanced Threat Scan Engine (ATSE) for
Deep Discovery.

Detected by YARA rule The file matches a YARA rule.

Detected by suspicious The file matches an entry in the suspicious objects list.

objects list

Detected by user-defined The file matches an entry in the user-defined suspicious

suspicious objects list objects list.

Detected by Predictive The file is detected by the Predictive Machine Learning engine.

Machine Learning engine

Detected by VA cache The file is already analyzed by Virtual Analyzer and is
considered as malicious.

File submitted to VA No pre-scan result is available for the file. Submit the file
sample to Virtual Analyzer for analysis.

The following header example indicates that the file and URL are considered
safe.

ICAP/1.0 204 No Content

Server: Deep Discovery Analyzer 6.8 Build 1165

ISTag: "12.300.1011"

X-Response-Desc: URL: No risk rating from WRS; FILE: No risk ra
ting from VA

Date: Thu, 16 Apr 2020 07:32:30 GMT

The following header example indicates that Deep Discovery Analyzer
returns the HTTP/1.1 403 Forbidden status code because the file is
detected by ATSE. The URL is not scanned.

Note

If you configure the redirect page in the management console, Deep Discovery
Analyzer sends the redirect page content after the HTTP 403 Forbidden header.

ICAP/1.0 200 OK
Server: Deep Discovery Analyzer 6.8 Build 1165
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ISTag: "12.300.1011"

X-Virus-ID: TROJ_FRS.ONA103DD20,TROJ_FRS.0ONA104DD20

X-Infection-Found: Type=0; Resolution=2; Threat=TROJ_FRS.ONA103

DD20,TROJ_FRS.ONA104DD20;

X-Response-Desc: URL: Bypass URL scanning in RESPMOD mode; FILE
Detected by ATSE

Encapsulated: res-hdr=0, res-body=86

Date: Thu, 16 Apr 2020 07:38:01 GMT

HTTP/1.1 403 Forbidden

The following header example indicates that the URL is considered as safe
and there is no detection information for the file. The file sample is
automatically submitted to Deep Discovery Analyzer for analysis.

ICAP/1.0 204 No Content

Server: Deep Discovery Analyzer 6.8 Build 1165

ISTag: "12.300.1011"

X-Response-Desc: URL: No risk rating from WRS; FILE: File submi
tted to VA

Date: Thu, 16 Apr 2020 07:22:41 GMT

Submissions Tasks

The following table lists all the Submissions tasks:

TABLE 4-4. Submissions Tasks

TAsK STEPS

Submit Objects Click Submit when you are done and then check the status on the
Processing or Queued tab. When the sample has been analyzed, it
appears in the Completed tab.

For details, see Submitting Objects on page 4-21.

To manually submit multiple files at once, use the Manual Submission
Tool. See Manually Submitting Objects on page 4-24.
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TAsK STEPS
Reanalyze Select one or more samples and click Reanalyze to:
Remove the existing analysis result
Resubmit the sample to the queue
Reanalyze the sample again, ignoring any cached data
This option is available on the Completed and Unsuccessful tabs
only.
Export All Export all displayed submissions to a CSV file.

This option is available on the Completed, Unsuccessful and ICAP
Pre-scan tabs only.

Detailed Information

On the Completed tab, click anywhere on a row to view detailed

Screen information about the submitted sample. A new section below the row
shows the details.
For details, see Detailed Information Screen on page 4-28.

Prioritize Objects On the Queued tab, select an object and click Prioritize to move the

object to the top of the queue.
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TAsK

STEPS

Data Filters

If there are too many entries in the table, use data filters to limit the
entries. Each tab uses a different set of data filters.

Available data filters on the Completed tab only:
Risk level: Filters by the Risk Level column.

Event logged: Filters by the Event Logged column. All time
periods indicate the time used by Deep Discovery Analyzer. If no
time period is selected, the default configuration of Last 24
hours is used.

Available data filters on the Unsuccessful tab only:
Error: Filters by the Error column.

Submitted: Filters by the Submitted column. All time periods
indicate the time used by Deep Discovery Analyzer. If no time
period is selected, the default configuration of Last 24 hours is
used.

Available data filter on the ICAP Pre-scan tab only:

Detected: Filters by the Detected column. All time periods
indicate the time used by Deep Discovery Analyzer. If no time
period is selected, the default configuration of Last 24 hours is
used.

The following options are available on all tabs:

All tabs contain a search box. Type some characters in the search
text box, and then press ENTER. Deep Discovery Analyzer
searches only the file names and URLs in the current tab for
matches. Performing a search on the Completed tab also
searches for child file names as well.

The Advanced link can limit the entries according to information
specified in one or more columns. For details, see Applying
Advanced Filters on page 4-20.
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TAsK STEPS

Customize columns To customize which columns appear in the table, click the gear icon

(5‘:@;5 ), select the columns to be displayed in the table, and click Apply.

Deep Discovery Analyzer saves the column settings for your user
account and displays the selected table columns the next time you
access the Submissions screen.

Records and The panel at the bottom of the screen shows the total number of
Pagination Controls samples. If all samples cannot display at the same time, use the

pagination controls to view the samples that are hidden from view.

Applying Advanced Filters

Procedure

1. Click Advanced.
The filter bar appears.

2. Inthe Filter drop-down box, select an attribute.

3. Depending on the attribute selected, specify any additional details
required by the attribute.

4. To add another attribute, click 4.
To remove an attribute, click x. You cannot delete the last filter.

5. Click Apply to immediately apply the filter to the current table.

Once applied, the following options are available:
- Edit: Modify the current filter

+  Clear: Removes the applied filter

- Save: Saves any changes made to the filter, or saves the filter under
anew name
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ﬁ’ Note

Filters are saved in the tab where they were created. However,
Deep Discovery Analyzer does not allow duplicate filter names,
even if they were saved in a different tab.

Click v on the search text box to view all filters saved for the
current tab. Selecting a saved filter immediately applies that
filter to the current table.

Click x to delete a saved filter.

6. Click Cancel to discard the current filter.
Submitting Objects
Procedure
1. Go to Virtual Analyzer > Submissions.
2. Click Submit Objects.

The Submit objects window appears.
3. To submit a single file, select File.

a.

b.

Browse and select a sample to upload.

(Optional) For Portable Executable samples, specify command line
parameters if required.

(Optional) Select Prioritize to put submitted objects at the top of the
queue.

Click Submit.

ﬁ Note

For archives, Virtual Analyzer merges analysis results for files inside
archives into one report.
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4. To submit a single URL, select URL.
a. Specify a single URL.

b. (Optional) Select Send to URL pre-filter to send submitted URLs to
the URL pre-filter. URLs found safe by the URL pre-filter are not
sent to Virtual Analyzer for scanning and analysis.

c. (Optional) Select Prioritize to put submitted objects at the top of the
queue.

d. Click Submit.

ﬁ’ Note

Before submission, Deep Discovery Analyzer normalizes all
occurrences of the following:

Punycode for URL domains

URL encoding for URL paths and query strings

5. To submit multiple URLSs, select URL list.

a. Browse and select a URL list file.

ﬁ’ Note

A URL list is a CSV or TXT file containing a maximum of 1,000 URLs.
For CSV files, specify URLs in the first column. The URL list file must
specify each URL in own line, and use UTF-8 encoding.

Before submission, Deep Discovery Analyzer normalizes all
occurrences of the following:

Punycode for URL domains
URL encoding for URL paths and query strings

Analysis of 1,000 URLs may take several hours.

b. (Optional) Select Send to URL pre-filter to send submitted URLs to
the URL pre-filter. URLs found safe by the URL pre-filter are not
sent to Virtual Analyzer for scanning and analysis.
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c. (Optional) Select Prioritize to put submitted objects at the top of the
queue.

d. Click Submit.

To upload applications which require certain files to be located in
specific paths, select Bundle file.

a. Browse and select an archive file.

ﬁ’ Note

For archives, Virtual Analyzer merges analysis results for files inside
archives into one report.

b. Specify which file inside the archive to run.

c. (Optional) For Portable Executable samples, specify command line
parameters if required.

d. (Optional) Select Prioritize to put submitted objects at the top of the
queue.

e. Specify where the files should be extracted.

To extract all files in the archive to a single folder, specify the
complete path in the Extraction Path text box.

To extract specific files in the archive to another path, specify
the File name and the complete Path for each file in the section
below.

Click + to specify a new file.
Click = to remove an entry.
f.  Specify the character encoding used in file names.

g. Click Submit.
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ﬁ Note

To manually submit multiple files at once, use the Manual Submission Tool. For
details, see Manually Submitting Objects on page 4-24.

Manually Submitting Objects

Use the Manual Submission Tool to remotely submit samples from locations
on users' computers to Deep Discovery Analyzer. This feature allows users to
submit multiple samples at once, which are added to the Submissions
queue.

In addition to Microsoft Windows operating systems, the Manual Submission
Tool supports the following Linux distributions:

CentOS/RedHat 5.x (32-bit and 64-bit)
CentOS/RedHat 6.x (32-bit and 64-bit)
CentOS/RedHat 7.x (32-bit and 64-bit)
Ubuntu 12.04 (32-bit)

Important

glibc.i686 and z11ib.1686 must be installed on 64-bit Linux distributions.

Manually Submitting Objects in Windows

Procedure

1. Ifitis not already installed, install the Manual Submission Tool. For
details, see Manual Submission Tool on page 6-96.

2. Go to the Manual Submission Tool package folder, open the work folder,
and then place all of the sample files or an URL list file into the indir
folder.

3. Run cmd.exe, and change the directory (cd) to the tool package folder.
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4. Depending on the type of object you want to upload, do one of the
following:

(’ Tip

Execute dtascli.exe for help.

. File: Execute dtascli.exe -uto upload all of the files in the work/
indir folder to Virtual Analyzer.

After executing dtascli.exe -u, cmd.exe shows the following,
along with all of the files that were uploaded from the work/indir
folder.

[2016-681-27 =39: =xxx yelcome to use submission tool vl.2.1885

[2A16-6B1-27 :39:84.391 indir: c: ission_vl.2.1885worksindir
[2016-681-27 :39:84,.392 i H ion_v1.2.1885worksoutdir
[2016-681-27 :39:84.3%4 |

[2016-681-27 :39:84,.39%

[2016-681-27 :39:85.823

2016-61-27 =39:85, 375 Unregister iz success

«  URLIist: Execute dtascli.exe -u --urlto upload the file
url.txt in the work/indir folder to Virtual Analyzer.

After executing dtascli.exe -u --url, cmd.exe shows the
following, along with all of the files that were uploaded from the
work/4ind1ir folder.

tnsubmission_vl.2.1885>dtascli.exe —u ——url
2816—81-27 15:38:27.873 INFO #*#x% yelcome to use submission tool vl. 2. 18685

[2016-01-27 15:38:27.87% INFO indir: c: i on_vl.2.18685worksindir
2016-81-27 15:38:27.878 INFO ir: civsubmission_vl.2.1885%worksoutdir
PA16-01-27 15:38:27,878 INFO Server: I

PA16-01-27 15:38:27.0881 INFO API Key: I
2A16—A1-27 15:38:27.758 INFO Register is success

2A16—A1-27 15:38:27.937 INFO Find URL sample: ahsgd

2016-—01-27 15:38:28.555 INFO Find URL sample: ahsd

2A16—A1-27 15:38:29.312 INFO Unregister is success
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ﬁ’ Note

The URL list must use the name URL. txt.

Before submission, Deep Discovery Analyzer normalizes all
occurrences of the following:

Punycode for URL domains

URL encoding for URL paths and query strings

After uploading the files to Virtual Analyzer, confirm that they are being
analyzed in the management console. Click Virtual Analyzer >
Submissions to locate the files.

Shortly after submitting the files, before they have been analyzed, they
appear in the Processing or Queued tab. When the samples have been
analyzed, they appear in the Completed tab. If the samples encountered
errors during analysis, they appear in the Unsuccessful tab.

Manually Submitting Objects in Linux

Procedure

1.

If it is not already installed, install the Manual Submission Tool. For
details, see Manual Submission Tool on page 6-96.

Go to the Manual Submission Tool package folder, open the work folder,
and then place all of the sample files or an URL list file into the indir
folder.

Open the terminal, and change the directory (cd) to the tool package
folder.

Execute chmod +x dtascli.

Depending on the type of object you want to upload, do one of the
following:
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Tip
Execute . /dtascli for help.

File: Execute . /dtascli -uto upload all of the files in the work/
indir folder to Virtual Analyzer.

After executing . /dtascli -u, terminal shows all of the files that
were uploaded from the work/indir folder.

URL list: Execute . /dtascli -u --urlto upload the file url.txt
in the work/1indir folder to Virtual Analyzer.

After executing . /dtascli -u --url, terminal shows all of the
files that were uploaded from the work/indir folder.

ﬁ’ Note

The URL list must use the name URL. txt.

Before submission, Deep Discovery Analyzer normalizes all
occurrences of the following:

Punycode for URL domains

URL encoding for URL paths and query strings

After uploading the files to Virtual Analyzer, confirm that they are being
analyzed in the management console. Click Virtual Analyzer >
Submissions to locate the files.

Shortly after submitting the files, before they have been analyzed, they
appear in the Processing or Queued tab. When the samples have been
analyzed, they appear in the Completed tab. If the samples encountered
errors during analysis, they appear in the Unsuccessful tab.
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Detailed Information Screen

On the Completed tab, click anywhere on a row to view detailed information
about the submitted sample. A new section below the row shows the details.

Submission details  Logged A172019 13:20:18 Sample 1D (SHA-1): comzas2 J05E752E74F043314B037
Source IP: MDS: 2919 15503BE395F Ds08C
Source port 17630 URL it ctvity/imgs/announce. po
Destination IP: [1c) Type: URL
Dectiatrloor =S i) e bt factiityfimgs/announ... General PDF 56023A72D399C9.
Pracessed by (node):
Raw Logs
MITRE ATTSCK™  Tactics Techniques
Framework
Defense Evasion: Fie Deletion
Notable characteristics ~ Process, senvice, or memory object change (1) File drop, download, sharing, or eplication (1) Suspicious network or messaging actviy (1)
Report BE
Investigation package  Download (password: vitus)
Global intelligence  View in Threat Connect (requires Internet connection)

The following fields are displayed on this screen:

INFORMATION
FIELD NAME
FILE/EMAIL MESSAGE SAMPLE URL SAMPLE
Submission Basic data fields (such as Logged, Basic data fields (such as Logged,
details File name, and Type) extracted from | URL, Source IP and port, and
the raw logs Destination IP and port) extracted

from the raw logs

ﬁ’ Note

Deep Discovery Analyzer may
have normalized the URL.

« Sample ID (SHA-1)

. Child files, if available, contained in or generated from the submitted
sample

«  TheP address of the node that processed the sample

+  The Raw Logs link shows all the data fields in the raw logs
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INFORMATION
FIELD NAME
FILE/EMAIL MESSAGE SAMPLE URL SAMPLE
Notable «  The categories of notable characteristics that the sample exhibits,

characteristics

which can be any or all of the following:

«  Anti-security, self-preservation

. Autostart or other system reconfiguration

- Deception, social engineering

. File drop, download, sharing, or replication

. Hijack, redirection, or data theft

. Malformed, defective, or with known malware traits
+  Process, service, or memory object change

+  Rootkit, cloaking

+  Suspicious network or messaging activity

. A number link that, when opened, shows the actual notable
characteristics

Other
submission logs

Atable that shows the following information about other log submissions:
- Logged

+  Protocol

. Direction

. Source IP

. Source Host Name

. Destination IP

. Destination Host Name

MITRE ATT&CK™
Framework

A list of MITRE ATT&CK ™ tactics and techniques detected. Click a link to
view more information on the MITRE website.




Deep Discovery Analyzer 6.9 Administrator's Guide

INFORMATION
FIELD NAME
FILE/EMAIL MESSAGE SAMPLE URL SAMPLE
Report The PDF icon (|i2) links to a downloadable PDF report and the HTML icon
(=) links to an interactive HTML report.
Note
An unclickable link means there were errors during simulation.
Mouseover the link to view details about the error.
Investigation Download links to a password-protected investigation package that you
package can download to perform additional investigations.
For details, see Investigation Package on page 4-31.
Global View in Threat Connect is a link that opens Trend Micro Threat Connect
intelligence . S .
The page contains detailed information about the sample.

Viewing Child File Detection Information

You can view the detailed detection information of child files in a submitted
sample.

Procedure

1. Go to Virtual Analyzer > Submissions.

2. Click the ICAP-Prescan tab.

3. Click the number in the Child Files column.
The Child File Detections screen appears.

The following table describes the information on the screen.

FIELD DESCRIPTION

File Name Name of the child file
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FIELD DESCRIPTION
File Type Filw type of the child file
Threat Name of threat as detected by Trend Micro pattern files and other
components
SHA-1 SHA-1 value of the child file
SHA-256 SHA-256 value of the child file
YARA Rule Name Name of the YARA rule that was matched
YARA Rule File Name of the YARA rule file that contains the matched YARA rule

Investigation Package

The investigation package helps administrators and investigators inspect and
interpret threat data generated from samples analyzed by Virtual Analyzer. It

includes files in OpenIOC format that describe Indicators of Compromise
(I0C) identified on the affected host or network.

The table below describes some of the files within the investigation package

that will aid in an investigation.

TABLE 4-5. Investigation Package Contents

PATH WITHIN THE INVESTIGATION PACKAGE

DESCRIPTION

\%SHA1%

Each folder at the root level, with an SHA-1
hash value as its name, is associated with one
object. More than one folder of this type will
only exist if the first object is an archive file or
an email message.

\%SHA1%\%imageID%

Associated with a sandbox image that
analyzed the object.

\%SHA1%\%imageID%\drop\droplist

Contains a list of the files that were generated
or modified during analysis.
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PATH WITHIN THE INVESTIGATION PACKAGE

DESCRIPTION

\%SHA1%\%imageID%\memory\image.bin

Contains the raw memory dump after the
process was launched into memory.

\%SHA1%\%imageID%\pcap\%SHA1%.pcap

Contains captured network data that can be
used to extract payloads. The file does not
exist If no network data was generated.

%SHA1%\%imageID%\report\report.xml

Contains the final analysis report for a single
object for a specific image.

%SHA1%\%imageID%\report
\blacklist.xml

Contains a list of all suspicious objects
detected during analysis. This file is empty if
no suspicious objects were detected during
analysis.

\%SHA1%\%imageID%\report\SHAl.ioc

Contains technical characteristics that
identify attacker’s tactics, techniques and
procedures or other evidence of compromise.

%SHA1%\%imageID%\screenshot\
%SHA1%-%N%. png

A screenshot of a Ul event that occurred
during analysis. The file does not exist if no Ul
events occurred during analysis.

\ common

Contains files that are common amongst all of
the samples.

\common\drop\%%

Generated or modified during analysis.

\common\sample\%SHA1%

The submitted sample.

\common\sample\extracted\%SHA1%

Extracted from the sample during analysis.

%SHA1%. report.xml

The final analysis report for all objects.

\%SHA1%\%imageID%\extrainfo

Contains files related to the sandbox image
that analyzed the object.

%SHA1%\%imageID%\extrainfo
\extra_info.xml

Contains additional details about the sandbox
image that analyzed the object.

%SHA1%\%imageID%\strings

Contains files related to the sandbox image
that analyzed the object.
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PATH WITHIN THE INVESTIGATION PACKAGE

DESCRIPTION

\%SHA1%\%imageID%\strings\
%SHA1%.string

Contains string dump retrieved from the
object during the analysis in the sandbox
image.

\%SHA1%.ioc

The IOC file.

\%SHA1%_1ioc.stix

The STIX10C file.

\%SHA1%_so.stix

The STIX SO file.

\%SHA1%_so_stix2.json

The STIX2 SO file.

\%SHA1%_ioc_stix2.json

The STIX2 10C file.

Investigation Package Data Retention

Deep Discovery Analyzer can retain the investigation package data for up to
100 days, but the time can be reduced due to storage limitations.

ﬁ Note

To ensure the availability of the investigation package data, Trend Micro
recommends backing up the data to an external server. For details, see Data

Backup on page 6-88.

The following examples illustrate how storage limitations can affect the
amount of time that the investigation package data is retained in Deep

Discovery Analyzer.

Based on testing done by Trend Micro, the average size of the investigation
package data is 8 MB. If Deep Discovery Analyzer analyzes 8000 samples per
day, then the resulting investigation package data is 64000 MB.

«  After about 62 days, the 4 TB disk from Deep Discovery Analyzer 1100 is
filled and the investigation package data is purged.

«  After about 62 days, the 4 TB disk from Deep Discovery Analyzer 1200 is

filled and the investigation package data is purged.
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If Deep Discovery Analyzer is in cluster mode, the disk space occupied per
day is multiplied by the number of appliances in the cluster.

+  Using the numbers from the example above, the investigation package
data for a cluster with five Deep Discovery Analyzer 1100 appliances is
purged after about 12 days.

+  Using the numbers from the example above, the investigation package
data for a cluster with five Deep Discovery Analyzer 1200 appliances is
purged after about 12 days.

Possible Reasons for Analysis Failure

If the Risk Level column shows a gray icon (¢ ), Virtual Analyzer has not
analyzed the sample. The following table lists possible reasons for analysis
failure and identifies actions you can take.

TABLE 4-6. Possible Reasons for Analysis Failure

REASON ACTION

Virtual Analyzer does | Check the supported file type list in the Virtual Analyzer > Sandbox
not support the file Management > Submission Settings tab.

format, or the file is
empty.

The available Check the sandbox image information in the Virtual Analyzer >
sandbox images do Sandbox Management > Images tab.

not support the file
format.

The URL exceeds the | Verify that the URL does not exceed 2,083 characters.
limit of 2083
characters.

Virtual Analyzer does | Check the password list in the Virtual Analyzer > Sandbox
not support the Management > File Passwords tab.

encryption or
compression format.
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REASON

ACTION

Virtual Analyzer does
not support the file
format.

Unsupported file type in current sandbox image. Check the sandbox
image information in the Virtual Analyzer > Sandbox Management >
Images tab.

Virtual Analyzer is
unable to access the
Internet.

Verify the connection of the management network to the Internet.

An unexpected error
has occurred on the
Sandbox for macOS.

Please contact your support provider.

The Sandbox for
macOS did not return
an analysis result
before the timeout
period expired.

Resubmit the object for analysis. If the issue persists, contact your
support provider.

Unable to establish a
connection to the
Sandbox for macOS.

Verify the connection of the management network to the Internet.

The URL is invalid.

Verify that the specified URL is in a valid format.

Extracted file sizes
exceeds total
limitation

Verify that the total file size of the extracted samples do not exceed the
specified limitation.

Archive extracted for
analysis. Child file
scanning is
unsuccessful.

See the scan results for the extracted files.

Virtual Analyzer is
unable to analyze the
object. The available
disk space is
insufficient.

Verify that the disk space is sufficient to perform the analysis.

Virtual Analyzer is
unable to analyze the
object within the
timeout period.

Resubmit the object for analysis. If the issue persists, contact your
support provider.
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REASON ACTION

Virtual Analyzer is Missing required files to execute the application. Use the Bundle files
unable to analyze the | option to upload the required files to analyze the object.

object. Dependencies
that the object
requires cannot be
found.

Virtual Analyzer is Resubmit the object for analysis. If the issue persists, contact your
unable to analyze the | support provider.

object. The object
crashes while being
analyzed.

Virtual Analyzer is Resubmit the object with the required command line parameters.
unable to analyze the
object. The object
must be run with the
correct command
line arguments.

Virtual Analyzer is Re-import an image with a valid license for Microsoft Office.
unable to analyze the
object. The Office
license has expired.

An unexpected error | Resubmit the object for analysis. If the issue persists, contact your
has occurred. Please | support provider.

resubmit the sample
for analysis. If the
issue persists,
contact your support
provider.

The license for the Please contact your support provider.
Sandbox for macOS
has expired.
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Suspicious Objects

Suspicious objects are objects with the potential to expose systems to danger
or loss. Deep Discovery Analyzer detects and analyzes suspicious IP
addresses, host names, files, and URLs.

ﬁ Note

If you register Deep Discovery Analyzer to both Deep Discovery Director and
Apex Central, Deep Discovery Analyzer uploads objects on the Suspicious
Objects list only to Deep Discovery Director.

You can check the synchronization status on the Deep Discovery Director
management console. For more information, see the Deep Discovery Director
Administrator's Guide.

Suspicious Objects

J Suspicious Objects ” User-defined Suspicious Objects

Suspicious objects are ebjects with the potential to expose systems to danger or loss. Objects in this list are automatically uploaded to the registered Deep Discovery Director or Apex Central server.
Show: | All v | | Search coumn: | Object v | [Search keywo Q] search tip

Last Detected | Expiration Risk Level Type Object

The following columns show information about objects added to the
Suspicious Objects list:

TABLE 4-7. Suspicious Objects Columns

COLUMN NAME INFORMATION
Last Detected Date and time Virtual Analyzer last found the object in a submitted
sample
Expiration Date and time Virtual Analyzer will remove the object from the
Suspicious Objects tab
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CoLUMN NAME INFORMATION

Risk Level If the suspicious object is:

IP address or domain: The risk level that typically shows is either
High or Medium (see risk level descriptions below). This means
that high- and medium-risk IP addresses/domains are treated as
suspicious objects.

URL: The risk level that shows is High or Medium
File SHA-1: The risk level that shows is always High
Risk level descriptions:
High: K